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1 Introduction 
The signal analysis software allows the user to quickly analyze the basic and some more advanced signal 
properties. It excels especially when comparing signals and looking for their common and distinct properties. 
This type of work is typically a part of a development process of tools and equipment for signal analysis based 
fault detection, machine monitoring and always when there is a need to detect statistically significant and 
persistent differences between signals.  
 
Accurate measurement of signals is another strong point of the FFT Properties. It makes all the sense, if one 
considers that the simplest way to tell two signals a part is to measure them. May that be frequency, amplitude 
or phase or other statistical properties, they can all be very accurately evaluated.   
 
With FFT Properties it is possible to specify analysis parameters such that your memory may run out, or it may 
take very long for the computation to complete. This is intentional to allow maximum customizability of all of 
the parameters. The customizability of the charts even allows for specific charting features to be disabled 
(broken) which can be fixed only with app restart. On the other hand this approach allows a large set of charting 
features.  It comes down to the customer to work out his/hers solutions. Some highlights: 
 

• One specialty of the audio playback is the ability to vary the playback sampling frequency on the fly and 
thus also the playback speed. It has well known that human ear is a signal analysis tool beyond compare. 
The rate conversion algorithms used to vary the playback speed is very accurate.  

• Included and known from version 3 is also the phase angle measurement algorithm. It allows accurate 
frequency, amplitude and phase angle measurement of any frequency, regardless of its alignment with 
the frequency bin grid. 

• Version 5 brings the spectrogram with accurate color information of every pixel. It is possible to take a 
look at the spectrogram and know exactly what the picture means for the underlying signal. The 
spectrogram imaging does not use standard image processing algorithms, because these were not 
designed to maintain the information given by the spectrogram.  

• Following in the path of the spectrogram is also a new surface chart tool. Full 360 degree rotation with 
axis labels, features color palette mixing options shared with the spectrogram analysis tool with the 
same “information” based approach. It allows building surface plots from large files without loss of 
accuracy. 

• True multi-channel and multi-format file support allows concurrent analysis and signal navigation 
through any combination of open files and channels. 

• Batch file processing supports digital filters, signal generators a wide range of rate conversion algorithms 
like modulators, demodulators and filters and has the capability to take advantage of all CPU cores in 
the system. 

 
As with previous versions, version 5 also comes with an SDK. SDK is a set of components that allow the user to 
rebuild individual features from the program in a matter of hours, if not minutes in the programming language 
of your choice.  
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2 First steps 

2.1 The Overview chart 

The quick-start demonstrates the key user interface features covering mouse and keyboard commands which 
would be sometimes difficult to guess. Start FFT Properties and select Open from the File menu. Select a wav file 
from you hard drive. The following dialog box will appear: 
 

 

Figure 1 Open file dialog. 

If the file has more than one channel, you can select the channel, you want to analyze. You have to open the file 
separately for each channel that you want to analyze, but there can be up to 32 channels open concurrently. 
There is also an option, to name the slot so that we can tell multiple channels from the same file a part. The file 
can have any number of channels. 
 
Once we press OK we get to see a window (Figure 3) with an overview chart on the top and two time-signal 
charts below. Although the Titles of each chart say Left and Right channel, this does not mean that we opened 
two channels. Chart Titles are completely user configurable.  
 
First we will concentrate on how to use the overview chart. (Figure 2).  

 

Figure 2 Overview chart. 
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Figure 3 Main window. 

Zooming 
To zoom in to the overview chart, simply click with the left mouse button and drag a rectangle with the mouse 
down and right. To zoom out of the overview chart, click and drag a rectangle with the mouse up and left. 
 
Panning 
Once the chart has been zoomed in, you can also pan the overview chart. Click and drag with the right mouse 
button the chart left and right. 
These two methods for zooming and panning are functional for all chart types except the surface chart.  
 
Analysis window selection 
By clicking inside the overview chart, we see that there is a vertical line displayed at that location and that time-
signal charts below the overview chart have updated. By zooming in around that vertical line, we can see a 
shaded rectangle.  (Figure 2) This shaded rectangle defines the signal that is selected for the analysis.  We can 
move the selection by clicking and dragging the left edge of the shaded rectangle. By dragging the right edge of 
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the rectangle, we increase or decrease the size of it. The analysis window size and position can also be defined 
explicitly. From the File menu we select Navigation and we get to see the Navigation window.  

 
 
Changing the Samples or the File position will also change the selection window. The window is semi 
transparent.  We can specify the forward/backward step for the file position by defining overlapping or the exact 
number of samples that we want to analyze. It is also possible to define step directly if we hold down CTRL key 
and double click inside the edit box.  
 

 
 
This number and step formatting box can be displayed for all edit boxes with up/down buttons.  It can also be 
very useful when either the time or some other value is very large or very small and we require scientific value 
formatting.  
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2.2 Playback 

We can hear the signal that we are watching at any time, by pressing the play button. 
 

 
 
The signal will always play from the current position in the signal.  The playback options are accessible from the 
Playback menu: 
 

 
 
While the signal is playing, we can change the playback speed and the screen update speed. The sampling 
frequency at which the signal is played back cannot be changed during playback.  To set a different increment 
for the Speed edit box, hold CTRL and double click inside the edit box.  By clicking in the overview chart, the 
playback position will change to the clicked position. By default the playback will loop the file. It is also possible 
to enable looping of only the zoomed-in file section, by pressing button: 

  
It is possible to play a signal from the file sampled with any sampling frequency. The rate converter will 
automatically upsample or downsample the original.  Only one channel will always be played back. That one 
channel that is currently displayed on the overview chart, will be played on both left and right channel of the 
audio card.  
 
The “Amplify to dyn. range”  allows playback of files which are not audio files and are not stored as 8bit or 16bit 
signed integers. By checking this box, the signal will be amplified for the playback purpose only so that it 
becomes audible. If the “Allow 24bit playback” option is checked, the signal will be scaled to match the 24bit 
dynamic range for playback, but the soundcard must of course support the 24bit sound playback.  
 
It is important to disable any “audio enhancing” features of the sound card drivers or any other similar drivers 
that may be installed on the PC.  These enhancements add additional filters that change the original sound. 
(Figure 4) 
 
These enhancements are automatically enabled for Creative Sound Blaster products for example. 
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Figure 4 Disabling audio enhancements (Windows Control Panel) 
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2.3 Slots 

The application can display up to 32 different signals concurrently.  Select File->Configuration. 

 

Figure 5 Slot configuration window 

The purpose of the slots is to store signal processing settings.  You can change the file in the slot and keep all the 
analysis settings that were set for the same slot previously.  When a new file is opened it is loaded in the first 
empty slot. If we want to load the file in the same slot as the currently selected slot that is displayed on the 
overview chart, you can select Replace from the File menu. All key operations are always applied to the 
currently selected and active slot. The active slot can be selected from the slot selection box which in this case 
shows “miller”: 
 

 
 
This is how it is possible to control, which file be played back and the settings for which data will be changed. It 
is also possible to select multiple slots and perform navigation and analysis concurrently on the selection. Use 
the CTRL and SHIFT keys to select multiple slots. The two buttons on the toolbar. 
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Indicate if the data from the current slot is displayed in the upper and lower chart. If both are pressed, the data 
is displayed in both charts. The two buttons are displayed only if there are two displays. Double clicking the  file 
in slot selection box will toggle the visibility of the data in the upper and lower chart. Another way to indicate 
which data we want to see in each chart is to press the button on the toolbar just above the chart: 
 

 
 
Pressing this button will present us with options on Figure 6. This button is available only for charts where it is 
possible to display data from multiple slots (files).  
 

 

Figure 6 Slot display selection 

When selecting multiple slots, the navigation chart will show data from all (Figure 7). The signal selection 
however will not be synchronized until the signal selection window is adjusted. (Figure 2) 
 

 

Figure 7 Multi-slot selection 

2.4 Common chart features 

Many charts share the commands visible on this toolbar: 
 

 
 
First three icons allow copying the chart as a wmf vector format to the clipboard, saving the chart to the file and 
printing the chart. The third icon allows us to edit the chart settings (Figure 8).  
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Figure 8 Editing the chart settings 

Individual charting features will not be explained in detail. Specific features like the “Marks” series are tied to 
the features of user interface when marking peaks and should not be changed. The chart editor allows the user 
to change everything, even if that breaks the program. This is an exception to allow the highest possible chart 
customizability. It makes sense to work out a solution first that delivers the required result and then work with 
it. Blindly clicking and changing settings will almost certainly result in unwanted behavior. Currently it is not 
possible to change or replace the series added by the program itself without breaking their self update feature. 
The titles are linked to the slot names.  
 

 

Figure 9 Chart functions 

 

Figure 10 Chart tools. 
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However it is possible to add new series that is based on one of the built in functions (Figure 9) and use a great 
set of chart specific tools (Figure 10).  FFT Properties uses these tools to perform peak marking and other 
operations and many of the features of the user interface are configurable from the chart editor. However, if 
you for example delete the peak marking tool, the user interface will no longer support peak marking. The 

solution to that is to restart the application and/or reload the 
default settings configuration.  In the future, there will be more 
options to customize something without breaking some other 
feature. 
 
It is also possible to examine the values of all series and copy their 
values to the clipboard (Figure 11)  
 
 

Figure 11 Examining values 
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3 File format support 
The file formats that can be read and written by FFT Properties include wav, dat, txt and raw/pcm file formats. 
The wav format includes sampling frequency information and channel count. The txt, raw and pcm formats do 
not store any information describing file contents. The sampling frequency, channel count, number format and 
real/complex must be specified when opening the file. Once this information has been gathered, a separate 
header file is stored next to the original file so that we have that information ready the next time we open the 
file.  
 
The dat file format  is specific to FFT Properties and also contains description of the data in the file, which can be 
any sampling frequency, channel count, number format and also analytical (complex) signal. 
 
With text file format it is especially important that we also consider non-visible and non-printable characters like 
tabs, line breaks etc… It is best to open the file first in a text editor, turn on the visibility of all special characters, 
delete any which don’t belong there and then open the file with the FFT Properties. The import filters can 
compensate for some errors in formatting, but cannot do magic. The windows notepad is not able to show 
special characters. An example of the file display of a good text editor is given here: 
 

 
 
Each empty space character is shown with a dot and every new line with a special character.  

3.1 The wave file format 

The wav file format import filter is applied to the files with the .wav extension. The file format allows storage of 
8, 16, 24 and 32 signed integers, 32 bit floating point and user specified (arbitrary) channel count.  The 
compressed aLaw and uLaw and ADPCM are also supported. The sampling frequency specified must be an 
integer. 

3.2 Text file format 

The text file format import filter is applied to files with .txt extension. The file format allows storage of multiple 
channels with full double precision number format. It does not store the sampling frequency. The text number 
format can be customized when writing.  If there is a .header file in the same directory as the data file, the 
missing parameters are read from the header file. In either case an extended file open dialog is opened: 
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In this dialog it is possible to specify the Sampling frequency. Two other parameters: precision and channel 
count are set automatically. The text file does not support multiple records in the same file and thus the Record 
number value is shaded out.  Changing the sampling frequency property will also modify the associated header 
file. It is also possible to create the header files manually. For reference we are listing here the contents of 
test_CNV.header: 
 
Sampling frequency = 11025 

Number of channels = 2 

Precision = 0 

Complex = false 

 
Only the first field, the sampling frequency is applicable. There is no empty first line and there can be any 
number of empty lines after the last entry. Example of the .txt file contents: 
 
-196 -200 

1200 1225 

2617 2674 

2406 2457 

2387 2436 

2369 2418 

2380 2429 

2375 2422 

 
There can be any number of empty lines before and after the data. The empty lines can contain one space or 
one tab character. The columns must be separated with one tab character. Each column represents data from 
one channel. The first channel has the number 0. After the last column there may not be any additional 
characters, like a tab.  
 
To specify complex numbers write the numbers as usual: 
 
1+2i  3+2i 
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1  2i 
2.123E+3i -3E-3i 
1+2i  3+2i 
1+2i  3.0+2i 
1E+5+2i  3+2.4i 
 

3.3 SFS text file format 

 
The SFS file format import filter is applied to files with .sfs extension. The format is similar the .txt format except 
that only one channel (column) can be specified. The file has a header defined with two lines, followed by one 
empty line: 
 
98304 
8.91646258503401 
 
-196 
-200 
1200 
1225 
2617 
2674 
 
The first line contains the number of values in the file and the second line contains the duration of the signal in 
seconds.  The data can also be complex. There can be empty lines after the last entry, but no special characters 
are allowed other than space in the rest of the file.  

3.4 ASC text file format 

The ASC file format import filter is applied to files with .asc extension. The file contains two columns. In the first 
column is the sample time and in the second column is the value obtained at that time. The two columns are 
separate with one tab character. The sampling frequency must be fixed. There can be empty lines before and 
after the lines with the data.  The data can also be complex. 
 
0   -1+i 
0.185759637188209 3 
0.371519274376417 2i 
0.557278911564626 6-3.4E-10i 
0.743038548752834 2617 

3.5 The raw and pcm file formats 

The raw and pcm file import filter is applied to files with the .raw and .pcm file extension. These are binary files 
which contain only data. If there is a .header file in the same directory as the data file, the missing parameters 
are read from the header file. In either case, when opening that file an extended open file dialog appears. We 
have to fill-in the missing information: Precision, Channel count and Sampling frequency. That information is 
then automatically saved to the header file. The header file has the same name as the original file, but different 
.header extension.  
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3.6 The DAT file format 

The DAT file import filter is applied to files with the .dat file extension. These are binary files with binary headers 
describing the contents. The header contains: 
 

• The length of data in number of samples. In case of complex numbers one sample are two values.  

• Sampling frequency. Stored as 64bit double precision. 

• Precision of the stored data. Stored as 32bit signed integer. (64bit floating point (0),  32 bit floating point 
(1) , 32bit integer (2), 24bit integer (10), 16bit integer (4)  or 8bit integer (6)).  

• Complex data or not. Stored as 32bit signed integer. 0 = false, 1 = true 

• Channel count. Stored as 32bit signed integer.  

4 Time signal analysis charts 
Time signal analysis is the default signal analysis screen that is displayed when the application starts. We can 
browse through the signal with the overview chart and display arbitrary number of slots on each time signal 
chart. The same signal can be displayed on both or none of the two charts. We zoom-in and zoom-out from the 
charts and pan in the same way as is this possible with the overview chart (See chapter 2.1). 

4.1 Auto peak scaling 

All the charts are always automatically scaled for both the left and the bottom axis. This means that the user 
almost never has to adjust the axis scale manually. By default peak scale mode is active. When we move through 
the signal with the help of the overview chart, the chart remains scaled at 20% above the largest maximum and 
20% below the minimum found. To reset the scaling back to 20% above and below of the current data maximum 
and minimum values press this button: 
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The 20% margin can be modified by the user in the Chart settings dialog.  (Tools->Axis scale) 

4.2 Value marks 

To enable value marking tool, we have to press this button: 
 

 
 
Then we can mark individual values by clicking with the left mouse button. The value marking tool will snap to 
the closest maximum, minimum or zero crossing or just the closest value depend on the setting defined. To clear 
all marked values, double click the chart. You cannot have marks concurrently on more than one series. The 
marks will be applied to the series which is associated with the currently active slot. Chapter 2.3 explains how to 
change the currently active slot. 
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5 Frequency spectrum charts 
We can browse through the signal with the overview chart and display arbitrary number of slots on each 
frequency spectrum chart. The same signal can be displayed on both or none of the two charts. We zoom-in and 
zoom-out from the charts and pan in the same way as is this possible with the overview chart (See chapter 2.1). 

5.1 Auto peak scaling 

All the charts are always automatically scaled for both the left and the bottom axis. This means that the user 
almost never has to adjust the axis scale manually. By default peak scale mode is active. When we move through 
the signal with the help of the overview chart, the chart remains scaled at 20% above the largest maximum and 
5% below the minimum found. To reset the scaling back to 20% above and below of the current data maximum 
and minimum values press this button: 
 

 
 
The 20% margin can be modified by the user in the Chart settings dialog.  (Tools->Axis scale) 

5.2 Value marks 

To enable value marking tool, we have to press this button: 
 

 
 
Then we can mark individual values by clicking with the left mouse button. The value marking tool will snap to 
the closest peak. To clear all marked values, double click the chart. You cannot have marks concurrently on more 
than one series. The marks will be applied to the series which is associated with the currently active slot. 
Chapter 2.3 explains how to change the currently active slot. 
There are multiple peak marking options available:   
 

• Single peak – only one peak is marked with one click 

• Harmonics – a harmonic series is marked with one click 

• Sidebands – modulation sideband search is possible by first marking the sideband 

• Modes – clicking the carrier and one more frequency shows the position of the sidebands 

• Free Style – any value can be marked 
 
Next to the peak marking options dropdown there is a mark type dropdown box which is showing “Amplitude” 
on our toolbar example: 
 

 
 
Spectrum types possible are: 
 

• Amplitude – shows only amplitude of the marked peak 

• Amplt & Phase – shows both amplitude and phase of the marked peaks 

• Phase – shows only phase of the marked peaks 
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Frequency spectrum

Frequency [Hz]
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Figure 12 Example of marked peaks with displayed amplitude and phase 

5.3 Filtering peaks 

The marked or clicked peaks can be filtered out of the signal. The algorithm generates a sine of the same 
frequency, amplitude and 180 degree out of phase and subtracts that signal from the original time series. The 
peak filtering is achieved with two buttons: 
 

 
 
However, this filtering is only functional while the numeric peak interpolation method is enabled in the Spectral 

analysis settings.  See also Figure 13. 
 

 

Figure 13 Peak interpolation settings 

 



21 | P a g e  

5.4 Logarithmic scale 

When we activate the logarithmic amplitude axis by clicking   , all the spectrums displayed will be switched 
to logarithmic.  

Sometimes it may be necessary to manually reset the peak scaling with the .  
The parameters for the logarithmic scale can be set in the Spectrum Analyzer settings dialog accessible from the 

main Options menu and from the toolbar: . See Figure 14. The spectral analysis settings are slot and analysis 
window specific. Each Analysis from the Analysis main menu has its own spectral analysis settings for each slot 
(file). 
 

 

Figure 14 Spectrum Analyzer settings 

5.5 Spectrum type 

Spectrum defines if the spectrum is a power spectrum, an RMS spectrum, peak to peak or amplitude spectrum.  
The following applies: 

• Amplitude spectrum– a sine signal with amplitude 3 on the input will show amplitude 3 in the frequency 
spectrum 

• Peak to peak spectrum-  a sine signal with amplitude 3 on the input will show amplitude 3*2 = 6 in the 
frequency spectrum 

• RMS spectrum -  a sine signal with amplitude 3 on the input will show amplitude 3/20.5 in the frequency 
spectrum 

• Power spectrum - a sine signal with amplitude 3 on the input will show amplitude 32 = 9 in the frequency 
spectrum 

 



22 | P a g e  

5.6 Frequency bands 

With the Bands page in the Spectral analysis settings, we can compute RMS of multiple frequency ranges. The 
amplitudes in the transition bands are damped linearly towards zero on each end of the bandpass filter. The 
RMS calculation takes in to account spectrum type and zero padding factor. 
 

 

Figure 15 Compute RMS from selected frequency ranges. 

With the reference box we can define: 
 
Sampling frequency 
The band parameters will be directly applied to the frequency spectrum in Hz. 
 
Nyquist frequency   
The band parameters will be applied relative to the sampling frequency, where sampling frequency means 1. 
The range for Nyquist frequency factors is from 0 to 0.5. This means that when we change the sampling 
frequency of the source and would like to see the RMS in the same section of the band, we don’t have to 
reconfigure the RMS calculation. 
 
Example: 
Sampling Frequency = 11025 
Transition start = 0.01 
Passband start = 0.02 
Passband stop = 0.03 
Transition stop = 0.04 
 
The actual Passband parameters are computed like this: 
 
Transition start = 0.01∙11025 = 11.025 Hz. 
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Passband start = 0.02∙11025 = 22.05 Hz 
Passband stop = 0.03∙11025 = 33.075 Hz 
Transition stop = 0.04∙11025 = 44.1 Hz 
 
The shape of the filter can be seen here: 
 
 
A 
 
 
 
 
 
 

 
 
Order frequency 
The band parameters will be applied relative to the order frequency, where order frequency means factor 1. 
 
Nth peak frequency 
The band parameters will be applied relative to the frequency of the select marked peak, where the frequency 
of the marked peak means factor 1. 

11.025  22.05   33.075  44.1 
Frequency [Hz] 
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5.7 Spectral statistics 

By checking the individual check boxes, the spectral statistics can be computed (Figure 16). “Frequency bin 
spacing” includes the effect of zero padding and “Frequency resolution” is the resolution of the spectrum, if it 
would have been computed without zero padding. “Frequency bins” is the number of spectral lines forming the 
frequency spectrum and is typically a power of two. The number of ”samples analyzed” can be any number, but 
is usually two times higher than the number of frequency bins, if zero padding is 1.  
 

 

Figure 16 Spectrum info and spectral statistics 

The following statistics is available: 
 
THD – Total harmonic distortion requires at least two marked peaks to be computed. It computes the ratio of 
the RMS of the marked peaks except of the first (most left) towards the first. 
 
THDN – Total harmonic distortion and noise requires at least one marked peak to be computed. It computes the 
ratio of the RMS spectrum without the marked peak towards the largest marked peak. Additional marked peaks 
increase the accuracy of the statistics. 
 
RMS – Root mean square of the spectrum. It is computed as the sum of squares of the peaks plus the sum of 
squares of the rest, thus providing additional accuracy. The spectrum type has to be set to amplitude for this 
statistic to give accurate result.  
 
NF – Computes the average of the noise, if the spectral components of the “signal”, which is not noise are 
marked. 
 
SFDR – Computes the ratio of the largest mark towards the second largest marked peak.  
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SINAD - Computes the ratio of the largest marked peak towards the rest. Marked peaks (except for the largest 
one) are considered to be the noise and are summed separately to compensate for leakage error and                                
avoid using Parsevals theorem. 
 
SNR - Computes the ratio of the sum of the marked peaks towards the rest of the spectrum. The marked peaks 
are considered the “signal” and the rest is the signal noise.  
 
To compute spectral statistics, the spectrum type can be any and left axis may not be logarithmic. Any error 
messages are displayed on the same dialog. 

5.8 Spectral reports 

Spectral reports allow us to quickly get the information from the spectrum analyzer. The number formatting 
follows the standard formatting options used to format the floating point numbers. If we don’t specify any 
formatting the full precision General formatting options is used. 
 

 

Figure 17 Reporting options 

 
An example of the report: 
 
Date/time: 12/3/2007 11:43:16 AM 

 

General info: 

 

Sampling frequency: 11025.000 [Hz] 

Bandwidth: 5512.500 [Hz] 

Samples analyzed: 512 

Frequency bins: 512 

Signal length: 0.0464399092970521 [s] 

Frequency resolution: 21.533 [Hz] 

Frequency bin spacing: 10.767 [Hz] 

 

Spectrum type: Peak amplitude 

Spectrum method: FFT 

Window: Hanning 

 

Marked peaks: 
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Frequency [Hz]           Peak amplitude           Phase [degrees] 

1367.358                 2054.06504084893         -123.034663843064 

 

 

RMS of frequency bands: 

 

Frequency range [Hz]                                                                                RMS 

0.000                    100.000                  300.000                  500.000                  487.352026649922 

 

Frequency lines: 

 

Frequency [Hz]           Peak amplitude           Phase [degrees] 

0.000                    7.11015784046243         0 

10.767                   7.35506250683671         -102.746699914351 

21.533                   9.10677521951946         -161.561674513481 

.. 

. 

 

5.9 Saving and loading settings 

On the bottom of the spectral analyzer dialog there is an Options menu: 
 

 
 
From this menu, we can Load and Save settings for the spectrum analyzer as a whole.  
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6 Averaged frequency spectrum analysis 
 
To compute an averaged frequency spectrum, we select the “Averaged spectrums” menu item from the Analysis 
main menu item.  First we have to make a selection to determine from which section the frequency spectrums 
should be computed. After that we specify the size of the window and overlapping or step between consecutive 
windows from which frequency spectrums will be computed. The signal section selection is made on the 
Overview chart: 
 

600s550s500s450s400s350s300s250s200s150s100s50s0s  

Figure 18 Overview chart 

To select a subsection of the signal, press and hold the shift key and the click and drag a rectangle with the left 
mouse button. The selection can be adjusted by dragging left and right selection edges. To select entire time 
signal, simply double click the chart. To compute the actual spectrums we can press this button 
 

 
 
or use the keyboard shortcut: F9. A dialog box will be displayed (Figure 19). Here we can specify the length of 
the signal window from which to compute the frequency spectrums and the windowing function to be applied. 
 

 

Figure 19 Averaging frequency spectrums 
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The sidelobe attenuation in dB applies to Kaiser Window only. We can specify how many windows we want and 
at what step are they taken from the selection. Once we press OK, the frequency spectrum is computed. The 
limitation of the averaged spectrums is that we cannot interpolate peaks and filter them out of the spectrum 
and that we have no phase information. We can however switch between logarithmic (dB) and linear scale.  
 
Any RMS bands must be defined prior to computing the frequency spectrum, to be evaluated (See Figure 15). It 
is of course possible to compare multiple averaged frequency spectrums on the same chart, by switching to a 
different slot (See chapter 2.3) and computing a new spectrum there. 
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7 Spectrograms 

7.1 Computing a spectrogram 

Spectrograms give us ability to analyze the signal with three parameters at the same time: Time, Amplitude and 
Frequency. The time is on the X axis, the Frequency is on the Y axis and amplitude is defined with the Color. 
Select the “Spectrogram” from the Analysis menu. First we have to make a selection to determine from which 
section the frequency spectrums should be computed. After that we specify the size of the window and 
overlapping or step between consecutive windows from which frequency spectrums will be computed. The 
signal section selection is made on the Overview chart: 
 

600s550s500s450s400s350s300s250s200s150s100s50s0s  

Figure 20 Overview chart 

To select a subsection of the signal, press and hold the shift key and the click and drag a rectangle with the left 
mouse button. The selection can be adjusted by dragging left and right selection edges. To select entire time 

signal, simply double click the chart. To compute the actual spectrums we can press this button    or use the 
keyboard shortcut: F9. A dialog box will be displayed (Figure 19). Here we can specify the length of the signal 
window from which to compute the frequency spectrums and the windowing function to be applied. 
 

 

Figure 21 Averaging frequency spectrums 
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The longer window we select, the higher will be the resolution in frequency and the lower will be the resolution 
in time. The window step defines the step between windows. Highest overlapping factor which still makes sense 
is 95%. Typically with 50%, we can be sure that we are not leaving anything out and all the signal information 
will be displayed. We can also specify negative overlapping which means that we will be leaving out parts of the 
signal. Usually we can do that when we want to computer very large spectrograms and want to save memory or 
CPU. It is very easy to specify spectrogram size that will exceed the size of the memory available to our 
operating system, that is why some trial and error is required and some caution is advised when setting these 
parameters.  

7.2 Pitfalls 

 
Many commercial software spectrogram analyzers do not allow the user to specify the overlapping factor and 
use that information to compute spectrogram in real time. If the signal selection is short, the overlapping is high 
and if the signal selection is short the overlapping is many times set to negative also (skipping signal data). To 
illustrate the difference between the two approaches we compare Figure 22 and Figure 23. Figure 22 shows 
spectrogram when the imaging takes care of displaying the huge spectrogram. 

Spectrogram

Time [s]

600550500450400350300250200150100500

F
re

q
u
e
n
c
y
 [
H

z
]

5,000

4,000

3,000

2,000

1,000

0

 

Figure 22 Spectrogram with 50% overlapping and 50000+ lines.  
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Figure 23 Negative overlapping with 1024 spectral lines 

Figure 23 shows the spectrogram, if we compute only so many spectral lines that we get one line for each pixel 
of horizontal screen resolution. Such spectrogram can be computed in real time and does not require a lot of 
memory. From comparison however it is self evident that the information provided by both is nowhere nearly 
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the same. The reason for differences is the aliasing effect which occurs because of under sampling of the 
spectrogram.  Figure 23 gives the appearance as if though there are vertical spectral lines present only from 
time to time and we can see from spectrogram on Figure 22 that they are present all the time. The important 
thing to notice here is that we cannot improve our picture on Figure 22 even if we zoom in, because we lose the 
overview of the entire signal and the information of the persistence of the spectral spikes across the entire 
signal. We can see if there is aliasing present in the spectrogram, if the picture substantially changes, if we move 
the signal selection start a little as we can see on Figure 24.  
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Figure 24 Negative overlapping with 1024 spectral lines, but different start in time. 

7.3 Toolbar settings 

 
The bottom chart (Figure 25) shows us the Color scale used for the spectrogram. In this case, the spectrogram 
was logarithmic and the scale maps dB in to color. 

 

Color Scale
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0

 

Figure 25 Color scale for the spectrogram. 

We can adjust the color scale by dragging the slider on the toolbar: 
 

 
 

By pressing the painter    we can select different color models. Very important button is also the peak scale 

button ( ) which resets the peak hold of the color scale when switching between multiple spectrograms or 

computing multiple spectrograms. To request the same color scale, peak hold scaling must be enabled ( ). 
 
The spectrograms namely are not comparable unless they have the same Color scale. One other important 
setting shows “Average” in the drop down box: 
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This edit box defines, how to draw the spectrogram on the chart: 
 

- Default: uses windows bitmap resizing functions to draw the bitmap in the region. When the 
spectrogram is too large for the Windows OS to handle, it will simply display nothing. This setting should 
typically only be used for reference. 

- Average: Uses bitmap resampling algorithm which computes an average value from all representative 
values in the spectrogram for each pixel to be placed on the screen. 

- Peak: Uses bitmap resampling algorithm which finds a peak value from all representative values in the 
spectrogram for each pixel to be placed on the screen. 

 

7.4 Spectrogram chart series options 

Multiple additional spectrogram formatting options are available from the Chart editor for the spectrogram 
 

 

Figure 26 Spectrogram chart series editor 
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8 Spectrogram analyzer 
Once we have learned how to work with the spectrograms in chapter 7, we can proceed to spectrogram analysis 
by selecting “Spectrogram Analysis” from the Analysis menu. On the right side of the spectrum we a frequency 
spectrum with frequency going from bottom to the top and amplitudes going from right to left. When we click 
anywhere in the spectrogram the frequency spectrum and time series below the spectrogram updates. We can 
also drag the cursor lines displayed on the spectrogram. 
 

 

Figure 27 Spectrogram analysis 

In the lower right edge, we can add trace lines to the time series chart which shows amplitude variations for the 
specific frequency as a function of time. By pressing the “+” signal we are presented with Wizard which guides 
us through multiple options. We can delete individual traces by pressing the “-“ button or delete all traces by 

pressing the button. 
 

By pressing , we can disable the display of the spectrogram and leave only traces. 

By pressing , we control if the cursor lines are displayed on the spectrogram. 
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9 Surface analysis 

9.1 Navigating the surface chart 

 
Surface analysis is another variant of the spectrogram analysis except that in this case the amplitude parameter 
is represented with color and height in the surface chart. The surface is computed in the same way as the 
spectrogram (See chapter 7). 
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Figure 28 Surface chart two color model 
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Figure 29 Surface chart peak scaled 

We can navigate through the surface chart with the help of the spectrogram below the surface chart by 
 

- dragging each border to increase or decrease the displayed region. 
- Press and hold CTRL key and drag the marked rectangle.  
- Press and hold the CTRL key and drag the border of the marked rectangle.  
- Zoom in and out of the spectrogram chart like with any other chart by clicking and dragging a rectangle 

down and right and to zoom out clicking and dragging a rectangle up and left.  
 
The surface chart itself supports the following: 
 

- Click and drag the chart with the left mouse button to rotate it. 
- Click and drag the chart with the right mouse button up or down to zoom in or out. 

 
Different configuration settings allow many different views and colors. 
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Figure 30 Surface chart, rainbow color scale 
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Figure 31 Three color model, with reduced Z scaling ( 
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9.2 Surface chart options 

The surface chart shares the Color scale settings with the spectrogram chart and same options apply. Surface 

chart specific features can be controlled from a dialog displayed when we press this button . 
 

 

Figure 32 Surface chart editor. 
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10 Signal processing 

 
Signal processing is provided as a file based processing. Each operation will result in a new file. File manipulation 
services like moving and deleting of files are implemented in the user interface. 
 

 

Figure 33 

Delete files ( ) command will delete the selected files and move files ( ) will move them.  Currently there 
are two methods to apply signal processing to the data: 
 

1.) With the batch file processing menu  available from the main File menu: 
 

 
 
The batch file processing allows easy selection of multiple files by filters and common output directory with the 
help of a Wizard. 
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2.) From the Processing menu, we can select operations which will use the currently selected slots as input, 

will store the result in the default “Work” directory and automatically open the processed files in the 
new open slot or replace the file in the existing one. 
 

 
 

We select the part of signal which we want to process with the signal selection tool ( ) available above the 
navigation chart. When applying this selection to multiple slots, it is important that we first select the slots and 
then adjust the selection. 
 
In case of digital filters, we can use the digital filter designer available in the “Digital Filter” main menu to avoid 
manual definition of the digital filter.  

10.1 Common settings of batch file processors 

 
All batch-file processing operations have some common settings. First we have to specify the list of files (Figure 
34). If we specify a wildcard for the Source Filter like *.wav and then press the “Add from filter”  button, all files 
in the selected directory ending with .wav will be added to the list.   
 

 

Figure 34 Input file definition 
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On the next page we can specify scaling and some basic math operations (Figure 35). 
 

 

Figure 35 Scaling factors 

All input signals will be scaled by the specified scale factor. The math expression gives further options like abs(x) 
or 2*x + 3 and so on, however all math operations are only single sample based. It is not possible to specify 
filters, subtract or add multiple signals and so on. Scaling is needed for example when converting 8bit to 16bit 
audio files.  
 

 

Figure 36 Destination file format 

The destination file format (Figure 36) can be specified independently from the input; however, there is no 
automatic scaling applied to compensate for the change in bitness or precision. When working with large files it 
makes sense to preserve source file format as long as possible. 
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Figure 37 Destination location 

The destination location (Figure 37) requires that we specify the destination directory and the suffix that will be 
appended to the resulting files.  All files with the same name in the destination directory will be overwritten. The 
file names will have the number of the channel appended to the name of the destination file. 
 

 

Figure 38 File section selection 

Sometimes it is desired to apply processing only to a selected part of the signal. In case of batch file processing, 
this selection must be done with first and last desired sample. To indicate all samples until the end of the file, 
enter -1  (Figure 38). 
 
To cancel the operation and the Wizard press the Esc key at any step or close the window.  
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10.2 Demultiplexer 

 
Demultiplexer will de-interleave multi-channel files. If we have a 2 channel wav files, de-interleave will result in 
two separate files: one with contents from the left channel and the second one with the content from the right 
channel. Demultiplexer will work through any number of files with user specified number of threads and can 
support any input signal channel count.  
 
Note that it is not necessary to demultiplex multi-channel files to analyze them. The channel number to analyze 
can be specified when the file is opened.  

10.3 Multiplexer 

 
The multiplexer will interleave two or more single channel files to form a new single multi-channel file. The 
output file format and precision always have to be specified. The order of the files in the source file list defines 
which file will be assigned to which channel.  

10.4 Digital filter 

 
Digital filter operation in case of batch file processing requires that the filter configuration is either loaded from 
the file or specified in the Wizard (Figure 39). The designer available here requires an experienced user or an 
already existing set of filter specifications. Digital filters are to be designed with a separate dedicated designer 
available from the “Digital filter” main menu.  
 

 

Figure 39 Digital filter options 

10.5 Cross-correlation 

 
Cross correlation performs convolution of the specified kernel with the selected part of the signal. If the kernel is 
the same as the signal, the operation results in auto-correlation. The kernel can be picked up from a slot, file or 
clipboard and examined with “View kernel” before continuing (Figure 40). 
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Figure 40 Cross correlation options 

The Kernel scaling check box enables pre-scaling of the kernel so that its maximum equals 1. Cross correlation is 
useful for finding multiple occurrences of the same event in a longer signal and finding their offset or time delay. 
If the kernel is a digital filter, the cross-correlation will result in a digital filter being applied to the signal.  
 
The kernel time series is typically much shorter or at best equal length to the signal which is being correlated. At 

the offset of best fit, we will get the highest response of cross correlation series. This best fit depends upon: 
  

1. frequency content 
2. absolute magnitude (signal strength) 

  
These two effects are always taken together with cross-correlation and cannot be treated separately. This 
means that one can get large response either because the signal strength increased or because the frequency 
content (including the phase) was a better match. 
  
First we have to select the part of the signal, which we want to analyze.  We switch to signal selection mode by 

pressing the button:   located on the toolbar above navigation chart. To select entire signal, double click the 
navigation chart. Then we can select the cross-correlation item from the processing menu to specify the second 
signal called kernel.  
 
The starting position of the kernel when performing cross-correlation will assume zeros appended at the 
beginning of the correlated signal: 
 
lag = - length(kernel) 
 
The final position of the kernel will be such that the last sample of the kernel will be aligned with the last sample 
of the correlated signal. (There are no zeros appended at the end of the correlated signal).  
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10.6 Signal generator 

The operation will generate one file, with user specified sampling frequency and sample count (Figure 41). The 
signal to be generated is specified with the dedicated editor. 
 

 

Figure 41 Signal generator 

10.7 Scaling function 

 
Simply scales all channels of all the specified input files by a specified scale factor.  

10.8 File convert 

 
Converts all input files to specified output file format. When converting bit depth or specified precision, there 
will be no automatic scaling operations applied. For example, an 8bit audio file has to be scaled by 256 to 
convert it properly to 16bit.   

10.9 Cut and copy 

 
Selected subsections of all input files will be extracted and stored in to a new set of files.  
 

11 Sampling rate processing 
 
Sampling rate processing group is a group of functions which all include a change in sampling frequency of the 
signal as part of their processing and always include all the required anti-aliasing filtering. Accuracy of the result 
depends greatly upon the destination file format. If the extra precision bits cannot be stored, the precision will 
be limited.  



44 | P a g e  

11.1 Common settings for sampling rate processing 

The anti-aliasing filters allow attenuation of the stop-band down to -180dB when using double precision version 
of FFT Properties. The width of the transition band is specified separately and always as a percentage of the pass 
band. Both of these parameters together define the actual filter. 
 

 

Figure 42 Anti-aliasing filter specification 

 

11.2 Sampling rate converter 

Rate conversion changes the original sampling frequency by a specified real number factor. If the specified 
factor is too small, then there might not be any output, because the filter length required would be longer than 
the length of the input signal to be converted. If the specified factor is too large, the processing time would 
become very long and disk space required would also grow proportionally. A reasonable conversion factor range 
is from 0.001 to 1000, although there is no built-in limit.  
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Figure 43 Rate conversion options 

11.3 Demodulator 

Demodulator will perform bandpass filtering around the specified frequency band and then translate the 
beginning of the band down to 0Hz. (Figure 44, Figure 45) In case of radio signals, we could interpolate an 
original 44 kHz signal to 4.4 MHz and then multiply that signal with a carrier frequency of 2MHz resulting in 
modulation sidebands from 2000 to 2022 KHz and from 2000 down to 1978 KHz. The demodulator would be 
able to perfectly extract the original signal, if the center frequency specified would be 2 MHz and bandwidth 
specified would be 22 kHz. The demodulator parameters in this case would be: 
 
Center Frequency = 2/2.2 = 0.90909090909 
Bandwidth = 0.022/2.2 = 0.01 
 
All other frequencies except for the pass band will be filtered out and final sampling frequency of the resulting 
signal would again be 44 kHz.  
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Figure 44 Demodulator options 

 

 
 
 

11.4 Modulator 

 
Modulator will increase the sampling frequency by Factor and moves the contents of the original signal to the 
specified Center frequency. The Center frequency must of course be less than Factor*FS/2 + Bandwidth.  Anti-
aliasing filtering is applied automatically.  
 

Fs1/2 Fs1/2 Fs2/2 = BW 

Before After 

BW 
Fcenter 

0 Hz 0 Hz 

Figure 45 Demodulation result. Note that sampling frequency after demodulation has been reduced to Fs2. 
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Figure 46 Modulator options 
 
 

 

 

11.5 Narrow bandpass filter 

The narrow bandpass filter which uses rate conversion will reduce the sampling frequency of the signal in order 
to reduce the computational cost while applying the filter. This is effective for a specific type of bandpass filters, 
which are very narrow relative to the signal bandwidth. If the signal to be filtered is long enough it is possible to 
apply fairly extreme filtering, where the bandpass represents 0.1% of the original bandwidth and transition 
bandwidth edges on each side of the band are 10x less.  There is no built-in limit on how narrow the bandpass 
can be other than the length of the signal. The length of the signal namely cannot be shorter than the impulse 
response of the filter.  

Fs2/2 = Factor*Fs1/2 

Fcenter 

0 Hz 

After 

BW 
0 Hz Fs1/2 = BW 

Before 

Figure 47 Modulation 



48 | P a g e  

 
 
 

Fs/2 

Fcenter 

BW 
0 Hz 

Figure 48 Narrow bandpass filter 
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12 Digital filtering 

12.1 Simple filter 

This filter designer can be activated by selecting “Simple filter” from the Digital filter main menu (Figure 49). This 
designer is intended to quickly design a working filter. We can examine the impulse response and also how does 
the signal from the currently selected slot look like when being filtered with this filter. 
 

 

Figure 49 Digital filter designer 

 
Once we have designed the filter such that it serves our purpose, we can apply the filter to the signal by 

selecting the slot, pressing  and selecting the section of the signal that we want to have filtered. To select the 
entire signal simply double click the navigation chart. The filtering is performed once we press F9 or press 

the .  Filter and display is configured with the help of the toolbar: 
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There are two methods provided for simplified filter design: 
 

 
 

 
 

When  is pressed, we can use the navigation chart to browse through the signal as usual and observe the 
filtered signal and frequency response at the same time. This is possible, if we have specified “Real data”  
instead of “Filter impulse” on the toolbar. 
 
Notes: 

• When checking the results, the filtered signal, you have to make sure that the spectrum analyzer is 
correctly configured. For example, it is not possible to see 100dB attenuation without using Kaiser 
window and setting its parameter to 100dB. In the filter designer, the spectrum analyzer settings are 
automatically adjusted and changing them has no effect. 

• When using single precision version of the application, the filter attenuation range especially is limited 
by available computational precision. For double precision the maximum range is about 180dB and for 
single precision that may be around 120dB.  

 

13 Orbital X-Y analysis 
 
This type of analysis has two applications: 
 

1. Allows the charting of the path of the center of the shaft inside the bearing. This requires a two channel 
file with data from X axis as channel 0 and data from Y axis as channel 1. The data has to be multiplexed 
(interleaved) and have a complex data flag. (Complex signal). 

2. Single channel orbital chart uses Hilbert transform to generate 90 degree phase shifted version of the 
original signal on the fly. This provides the same information as the first case, except that the center of 
the shaft is fixed at position X = 0 and Y = 0.  

 
Picture can be substantially improved in both cases by interpolating the signal to sampling frequency about 4 or 
more times higher, before performing the analysis (See 11.2 Rate conversion). The sampling frequency in case of 
the Hilbert transform should not be raised too much, to prevent high pass filter to cut off low frequency 
content. The first 2% of the signal bandwidth is attenuated by the Hilbert phase filter.  
 
The chart can display multiple signals. If a signal is shown on the chart or not, is defined with the button circled 
on the toolbar: 
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The other important feature is the angular scaling: 
 

 
 

The “reset scale”  button will adjust the radius of the chart to have the currently active signal displayed in 
the visible range. The radius of a circle drawn, can be adjusted also directly with the help of the edit box.  
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Figure 50 Orbital chart without interpolation 
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Figure 51 Orbital chart of a signal with 4x higher sampling frequency 
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